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ABSTRACT 

 

Understanding the use of technology and sampling are important skills for auditors and 
fraud investigators. This case addresses these requirements by providing an opportunity for 
students to use ACL to analyze a population of transactions, select a random sample from that 
population and then vouch the selected records to another file that acts as the original source 
documents. Students use ACL to evaluate the results. They conclude as to whether or not the 
sample supports reliance on the control being tested. 

Teaching notes and other solutions are often available through the internet, increasing the 
risk of plagiarism. An option in ACL allows each student to select a different sample from the 
population. Additionally, the instructor can easily change the population being audited to vary 
both the number and type of errors found in the population. Therefore, based on a changeable 
sample selection method and population, the results are never the same each time the case is 
used, making it practically plagiarism proof.  
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INTRODUCTION 

 

Understanding the use of technology and sampling are important skills for auditors and 
fraud investigators. The ACFE’s Fraud Examiners Manual discusses the use of data analysis and 
reporting tools (ACFE, 2019). Likewise, the Institute of Internal Auditors states in standard 
A1210.A3 that internal auditors must have knowledge of “technology-based audit techniques to 
perform their assigned work” (IIA, 2017). The CPA Exam Blueprint for Auditing and Attestation 
states in Area III B that candidates should have an understanding of sampling techniques 
(AICPA, 2019). Finally, proposed change #13 to the CPA exam add the concept of using 
automated tools and audit data analytics in sampling (AICPA, 2019).  

This case addresses these requirements by providing an opportunity for students to use 
ACL to analyze a population of transactions, select a random sample, and vouch the records to 
another file that acts as the original source documents. Students evaluate the results and conclude 
as to whether or not the sample supports reliance on the control being tested.  

The case also contains features to reduce the opportunity for plagiarism. While teaching 
notes are generally distributed to instructors, both they and solutions developed by others can be 
obtained through the internet. For example, the Wall Street Journal investigated 100 web sites 
“offering tutoring help or writing services, or both.” The costs were “$15 for math assignments 
to a few hundred dollars to complete entire online courses” (Hobbs, 2019). Therefore, a 
significant risk exists that students seek out and use solutions created by others rather than doing 
their own work. 

To address the risk of plagiarism, this case provides two options for instructors to modify 
the case so that the results are never the same each time it is used. First, the risk of plagiarism 
can be reduced by having students select a random sample that is unique to them. Second, the 
instructor can easily vary the number and type of errors found in the population from which the 
students draw the sample.  

A final feature of the case is that the instructor can illustrate sampling risk by having 
multiple students select unique samples. The number of errors found will vary from sample to 
sample. Comparing multiple results provides an opportunity to illustrate and discuss sampling 
risk.  

 
THE CASE STUDY 

 

Background Information About the Client 

 

Never the Same, Inc., (NtS) issues multiple contracts related to the sales of products. 
Specific individuals within NtS have authority to approve contracts (approver) based on the 
dollar amount and the department charged with issuing the contract. Determining whether 
contracts have been approved by an appropriate individual is one of the primary tests of NtS’ 
internal control over revenue recognition.  

NtS must provide quarterly financial reports to its lender to show that it complies with 
certain liquidity and profitability requirements (e.g., current ratio, gross margin, earning per 
share, etc.) that are included in the loan agreement. Management of NtS has struggled to meet 
these requirements and will continue to struggle in the foreseeable future. Failure to comply with 
the loan agreement allows the lender to demand immediate payment in full. While there is no 
evidence that fraudulent transactions exist, the partner in charge decided to assess a high risk for 
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improper revenue recognition and therefore needs to determine that contracts were properly 
approved.  

As part of the background information for the engagement, NtS provided their contract 
approval policy that lists the approvers, the department(s) for which they have approval 
authority, and the approvers’ dollar limits as indicated in Table 1 (see Appendix).  

All approvers are assigned to a single department (except WB) since the types of 
contracts coming from that department align with the approver’s expertise. The risk of an error in 
revenue recognition increases when an approver signs off on contracts from other departments or 
above their dollar limit.  

In addition to this policy, the audit team has an ACL project containing a summary of all 
contracts issued for the current quarter. As described in Figure 1 (see Appendix), this ACL 
project has four items saved in the Contracts Ledger table.  

• Contract number which are consecutive numbers 1 - 2,000.  

• Contract amount in dollars.   

• Department that originated the contract.  

• Approver’s initials who approved the contract.  
 

The total dollar amount for the 2,000 contracts is $13,304,236. NtS stated that the 
information in the Contracts Ledger was accurately copied from the original contracts. The audit 
team will have access to NtS’ Contracts Database (explained below), which holds information 
about the original contracts.  

 
Requirements 

 
The audit team will first test the records in the Contracts Ledger by reviewing them for any 

obvious errors. Then they will select a random sample from the Contracts Ledger, and vouch the 
approver as listed in the Contracts Ledger to the approver identified in the Contracts Database. 
Once the testing of the sample is complete, the audit team will project the results of the sample 
back to the population, document their results, and discuss whether or not the sample supports 
the conclusion that the control is properly working.  

The following explains the requirements in detail. The first two questions can be answered 
without starting ACL.  
1. A good starting point is to determine if there are any obvious errors in the Contracts Ledger. 

Considering that the Contracts Ledger is saved as a table in ACL, what tests could the audit 
team plan to run with ACL to see if the information is consistent with NtS’ approval policy 
and other information they provided?  

2. There are two approaches to sampling: statistical and non-statistical. Explain how they are 
similar and dissimilar.  

3. Obtain and open the NtS Contract Audit ACL project as well as the Contracts Database. 
Your instructor will provide instructions about how to do this.   

4. Use ACL commands to test if there are any obvious inconsistencies between the data 
recorded in the Contracts Ledger and the policies described in the background information 
and Table 1 (see Appendix).  

5. Use ACL to calculate an attribute sample size based on the following parameters (or other 
parameters given by your instructor).  

a. Confidence level: 95% 
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b. Upper Error Limit (sometimes called Tolerable Error): 5% 
c. Expected Error Rate: 1% 

6. Use ACL to select a random sample of records for the sample size determined in step 5. Your 
instructor will indicate what number to use for a seed. You should save the sample as an 
ACL table and then export that table into an Excel file.  

7. Vouch the approvers in the sample to the approvers shown in the Contracts Database. Open 
the Excel file created in step 6 and add two column headings, “Vouched to Contracts 
Database” and “Description of Error.” For each record in the sample, vouch the approver to 
the corresponding record in the Contracts Database. An error occurs when the approver as 
listed in the sample does not match the approver identified on the contract recorded in the 
Contracts Database. Record the results in the “Vouched to…” column by entering a “1” if 
there is a discrepancy and a “0” otherwise in the cell. When there is an error, explain the 
error in the “Description…” column. 

8. Evaluate the sample. Count the number of records that violate the approval policy. Use ACL 
to quantitatively evaluate the results of the sample and project the results of the sample to the 
population. Consider if there are any qualitative issues that the auditor should review. Based 
on the test results, determine whether or not the sample indicates that NtS is following its 
contract approval policy.  

9. Document the results of Steps No. 4 – 8.  
 
Contracts Database 

 

The Contracts Database is an Excel file that substitutes for NtS’ copies of the original 
contracts. It is used in the following way. Refer to Figure 2 in the Appendix.  

Once the sample is selected from the Contracts Ledger, enter each contract number in the 
space provided in the Contracts Database. The Contracts Database will display one of the 
following:  

• The initials of the person who actually approved the contract. This may be the same 
or different from what is shown in the Contracts Ledger.  

• A message that the contract was found but does not have an approval. 

• A message that the contract cannot be found. 
For example, Figure 2 shows the auditor entered contract number 1502. The database 

showed that the original contract was approved by JJ. 
This approval should be compared to the approval found in the sample. Then, document 

the agreement, or lack of agreement, on the Excel work paper. The vouching process is repeated 
for all records in the sample.  

 
TEACHING NOTES 

Objectives and Background 

This case is designed to be completed as part of an introductory auditing or fraud 
investigation course. Prior to completing the case, the students should have covered basic 
concepts on sampling and ACL. This case is intended to provide an example of how sampling 
can be used to test compliance with a policy and to illustrate the use of ACL software.  

As part of this assignment, students will:  
• Investigate a table saved in an ACL project. 
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• Use ACL to calculate a sample size and select a random sample. 
• Vouch the sample back to source documents and document the results of the test. 
• Use ACL to project the errors found in the sample back to the population.  
• Conclude as to whether or not the sample supports reliance on the control.  
• Compare their results to others auditing the same population via a different random 

sample. The differences in results will illustrate sampling risk.  
A unique feature of this case is that it has two options to reduce plagiarism. First, the 

instructor can have students select different random samples by varying the seed number that 
ACL uses to select the sample. Second, the instructor can also change the population being 
audited, i.e., the Contracts Database, in two different ways: by varying either the number of 
errors or the types of errors in the population. See Updating the Contracts Database section 
below. Therefore, if either of these are done, students select different samples that are never the 
same as samples used by students who previously completed this case. This dramatically reduces 
the opportunity for plagiarism.  

Students completing this case should have a basic understanding of the ACL software. 
This would include using the following ACL commands: Count, Gaps, Duplicates, Sequence, 
Statistics, Filter, Export, Total Fields, Cross-tabulate, Calculate Sample Size, Sample Records, 
and Evaluate Error. 

 
Retrieving Audit Files 

 

 The author has uploaded a zipped file related to the implementation of this case to a 
Google drive folder that can be reached via the URL: https://tinyurl.com/NtSFiles.  The zipped 
file contains: 

• An ACL audit project file named NtS Contract Audit. 

• Contracts Database.xlsx – This file has 24 errors randomly inserted into the 
population.  

o 12 indicate the contract was approved by someone other than the name listed 
on the Contracts Summary. 

o 12 indicate that the contract is found but is missing an approval. 
o In this file, the Contract Detail worksheet is hidden and password protected. 

The password for this file is “nts2x” (without the quotation marks). 

• Contracts Database Original.xlsx – This is an original version of the Contracts 
Database that contains the Contract Look Up Form and Contract Detail worksheet 
(see Appendix, Figures 2 and 3). It does not contain errors. The Contract Detail 
worksheet must be modified by the instructor for use in his/her class prior to using the 
case and then hidden. Instructions on how to modify and password protect the file are 
in the section Updating the Contracts Database below. 
 

The next section provides answers to discussion questions and illustrates how students 
might implement the case’s requirements. 



Journal of Business Cases and Applications   Volume 27 

Never the Same, Inc., Page 6 

Suggested Solutions and ACL Processes  

 
The numbering in this section corresponds to the numbering in the Requirements Section 

of the case. The following provides guidance on how each requirement can be implemented. 
 

1. What tests will the audit team plan to run with ACL to see if the information is 

consistent with NtS’ approval policy and other information provided?  

 
 In order to review the contract data, the following are possible with ACL:  

• Count the number of records to see if they agree with the NtS’ control total of 2,000. 

• Run Duplicates, Gaps, and Sequence on the Contract Number to look for duplicated, 
missing, or out of order numbers.  

• Total the records to see if they agree with the NtS’ control total of $13,304,236. Run 
Statistics to see if there are any contracts with negative or zero balances.   

• Filter the Contracts Ledger by Approver and then run statistics on the Contract 
Amount. This will show the highest value for each approved contract. Determine if 
the highest value exceeds the approver’s limit.  

• Crosstab by Approver and Department and count the number of records in each cell. 
For example, all contracts from Department A should be approved by either AJ, SP, 
or WB.  
 

2. Explain how statistical and non-statistical sampling are similar and dissimilar.  

 
There are two approaches to sampling: non-statistical and statistical. Both are ways to 

study a portion of a population in order to learn about some aspect of the entire population. 
 Auditing standards and other professional literature permit the use of both nonstatistical 
and statistical sampling to estimate either the rate of deviation from a control procedure or the 
amount of dollar error in a population. The primary differences between non-statistical and 
statistical relate to how the auditor determines the sample size and evaluates the results.  
 Non-statistical sampling relies on professional judgement to determine the sample size 
and estimate the likelihood that the error rate in the sample differs from the actual error rate in 
the population.   
 Statistical sampling uses a quantitative approach to determine the sample size, a random 
process to select the sample, and another quantitative approach to project the results of the 
sample back to the population. The analysis provides a degree of confidence that the sample 
represents the actual error rate in the population. 
 For example, assume an auditor finds two errors in a sample of 100 when testing a 
control procedure. With non-statistical sampling, the auditor cannot quantitatively express the 
likelihood that the error rate in the population differs from the 2% error rate in the sample. The 
auditor must make that decision with professional judgement.   

On the other hand, with statistical sampling, the auditor can state with 95% confidence 
that the error rate in the population does not exceed 6.30%. Since there is a chance that the 
sample was not representative of the population, the analysis adds to the 2% deviation rate in the 
sample an “allowance for sampling risk” of 4.30%. The sample’s error rate of 2% plus the 4.30% 
allowance for sampling risk leads to the maximum error expected to be found in the population 
(6.30%) for the stated confidence level (95%). The audit software completes this calculation. 
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3. Obtain and open the NtS Contract Audit ACL project as well as the Contracts 

Database. 

 
The instructor should give students directions about how to obtain the NtS Contract Audit 

ACL project and the Contracts Database. One suggestion is for the instructor to downloaded the 
files from the Google drive (https://tinyurl.com/NtSFiles) and post them on the course’s learning 
management system.    

 
4. Use ACL commands to test if there are any obvious inconsistencies between the data 

recorded in the Contracts Ledger and the policies described in the background 

information and the approval policy listed in Table 1 (see Appendix).  

 
It is good practice for auditors to become familiar with the data they are examining, 

reconcile it wherever possible to the client’s control totals, and look for unusual items that are 
inconsistent with their understanding of what should be in the data. 

The data in the ACL table is the client’s ledger of all contracts issued for the current 
quarter. The table has four items: contract number (1 - 2,000), contract amount, department (A - 
D), and approver. Students can use the actions described in the solution for Step No. 1 to analyze 
the data. For example, students can test for the following: (1) gaps and duplicates in the contract 
numbers; (2) negative or zero values for contract amounts by using the statistics command; and 
(3) an incorrect total amount of contracts by using the total command. Additionally, by cross-
tabbing on department and approver, students can determine if a contract from a given 
department was approved by someone who did not have authority to approve a contract from that 
department.  

If the original Contracts Ledger table is used, all data is consistent with the background 
information provided in the case. In other words, there are no unusual items. Nevertheless, the 
instructor can point out that it is important for the auditor to confirm the accuracy of the data by 
comparison to control totals and other background information provided by the client. 

 
5. Use ACL to calculate an attribute sample size based on the following parameters (or 

other parameters given by your instructor).   

a. Confidence level: 95% 

b. Upper Error Limit (sometimes called Tolerable Error): 5% 

c. Expected Error Rate: 1%  

 
Students can calculate the sample size by selecting the following commands in ACL: 

Sampling -> Calculate Sample Size -> Record. Based on the information given above, the 
sample size should be 95 records. The case is not dependent on a particular sample size. 
Therefore, the instructor can modify one or more of the sample size parameters in order to vary 
the case from semester to semester. 

 
6. Use ACL to select a random sample of records for the sample size determined in Step 

No. 5. Your instructor will tell you what number to use for a seed. You should save the 

sample as an ACL table and then export that table into a new Excel file.  
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Students can select the sample by using the following commands in ACL: Sample -> 
Sample Records -> Record and Random. In ACL’s “To” box students should enter the name of 
the ACL table where the sample will be saved. Students then use the ACL command Data -> 
Export to export the ACL table containing the random sample to Excel.  

As calculated in Step No. 5, the sample size is 95. To provide each student with a 
different sample, they should use a unique seed number, which is a value utilized by an 
algorithm in the ACL software to select a unique sample. The author typically asked the students 
to enter their student identification number as the seed value.  

Each unique seed results in a different list of random numbers. Therefore, by varying the 
seed, each student will have a different set of records for the sample pulled from the population. 
Accordingly, they will likely have different conclusions about the error rate in the population, 
which can be used to discuss sampling risk. See Discussion of Sampling Risk below.  

 
7. Vouch the approvers in the sample to the approvers shown in the Contracts Database.  

 
To complete this requirement, students will enter each contract number included in the 

sample into the Contracts Database worksheet titled, “Contract Look Up Form” in Figure 2 (see 
Appendix). After the contract information for the specific contract number is displayed, students 
will compare the information on the screen to the approval information provided in their sample. 
In the Excel worksheet containing their sample, students will enter a “1” if there is a discrepancy 
along with a description of the error and a “0” otherwise.  

 
8. Evaluate the sample.  

 
The number of errors that students find will vary if each student used a different seed to 

generate their random sample. 
Students can evaluate their sample by selecting the following commands in ACL: 

Sampling -> Evaluate Error -> Record. Based on the instructions given in the case, the 
confidence level is 95% and sample size is 95 records. The number of errors will depend upon 
each student’s sample and findings.  

The ACL program will provide the Upper Error Limit (or Tolerable Error Limit). 
Students should compare this Upper Error Limit to that used for audit planning, which was 5% 
for this case. If the calculated Upper Error Limit exceeds the Upper Error Limit used for 
planning, the sample does not support reliance on the internal control.  

Depending upon how the instructor has set up the Contract Detail Worksheet (see Figure 
3 in Appendix), there may be qualitative issues. For example, the instructor may select option 3 
and have approvals missing from contracts. Further, the instructor may select option 4 for a 
given record, which indicates the contract is missing. Students can then assess the impact the 
type of error has on their conclusion.  

 
9. Document the results of Steps No. 4 – 8.   

 
In this step, a good source for guidance is the AICPA’s Audit Sampling audit guide, 

paragraph 3.96, “Documenting the Sampling Procedure” (AICPA, 2017). Another source for 
documentation would be the examples typically given in a chapter on attribute sampling in a 
principles of auditing textbook. It is important to include in the final documentation the Excel 
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work paper showing the results of comparing each record in the sample to the Contracts 
Database. The instructor should provide any course specific requirements about the format of the 
documentation he/she requires.  

Discussion of Sampling Risk 

 

Since each student uses a different random sample, results will vary. Some students will 
find zero errors while others will find one, two, or more errors. An interesting exercise is for the 
instructor to summarize the number of errors found by each student and ask the students to 
explain why there can be different results when they obtain a sample from the same population.  

The primary reason for the differences is sampling risk or the risk that a sample may not 
be representative of the population from which it is drawn. In some cases, the number of errors 
will cause the projected upper error limit to exceed the upper error limit (or tolerable error rate) 
used for planning purposes. In these cases, the auditor may decide to increase the original sample 
size in order to determine if this has an impact on the conclusion. Alternatively, the auditor may 
decide to not rely on the control being tested and to rely on compensating controls. Finally, the 
auditor may decide to reduce reliance on internal control and increase other types of testing.  

Table 2 (see Appendix) illustrates results after the author ran the case using 25 different 
seeds to select samples from the same population. The population had 24 errors (half incorrect 
approver and half missing approver) randomly distributed through the 2,000 records. 

In ten of the 25 samples, there were no errors when vouching the approver from the 
Contracts Ledger to the Contracts Database. Using a 95% confidence level, ACL computed the 
maximum projected error rate to be 3.13%. 
 In eight of the 25 samples, there was one error in each sample when vouching the 
approver from the Contracts Ledger to the Contracts Database. Using a 95% confidence level, 
ACL computed the maximum projected error rate to be 4.95%. Three of the errors were an 
incorrect approver and five of the errors were a missing approver. Students who find these types 
of errors would consider if there are any qualitative issues. For example, did the sample identify 
an error that is an isolated instance? What should be done to determine if there is a larger 
problem?  
 The same type of interpretation used for the one error cases can be used for the samples 
with two, three, or four errors. Does the sample contain an isolated instance? What should be 
done to determine if there is a larger problem?   
 
UPDATING THE CONTRACTS DATABASE 

 
The instructor should complete these steps each time he/she wishes to make changes to 

the Contracts Database Original. This creates a unique population for the students to sample, 
virtually eliminating the opportunity for them to copy the work performed in previous courses. 

The Contracts Database Original is an Excel file that contains two worksheets: Contract 
Look Up Form and Contract Detail.  

The first worksheet was shown in Figure 2 (Appendix). Students use this worksheet to 
look up contract approval information to vouch to the sample drawn from the Contracts Ledger.  

The second worksheet, Contract Detail, is shown in Figure 3 (Appendix). This worksheet, 
only viewed by the instructor and hidden from the students, contains the information that will be 
displayed on the first worksheet that students will use to perform the internal control test.  
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The Contract Detail worksheet contains six columns, titled: (1) Contract Number; (2) 
Use; (3) Correct; (4) Incorrect; (5) Missing Approval and (6) Missing Contract.  

The “Contract Number” column contains numbers 1 – 2,000. These values correspond to 
the contract numbers that are included in the Contracts Ledger. The students will enter these 
numbers in the Contract Look Up Form.  

The “Use” column must contain a number from 1 through 4. If other values are entered, 
no information will be displayed on the Contract Look Up form. Excel functions in the file rely 
on the values in this column to identify the contract approval information to be displayed on the 
Contract Look Up Form. The numerical code and the message revealed on the Contract Look Up 
Form are as follows:  

• If Use = 1, column C, Correct Approver, is displayed on the Contract Look Up Form. 

• If Use = 2, column D, Incorrect Approver, is displayed on the Contract Look Up 
Form. 

• If Use = 3, column E, Missing Approval, is displayed on the Contract Look Up Form. 

• If Use = 4, column F, Contract Missing, is displayed on the Contract Look Up Form. 
Prior to giving the Contracts Database to the students, the instructor must determine the 

number and type of errors he/she wishes to have in the population. Currently, every approver in 
the ACL project’s Contracts Ledger is the same as the approver listed in Column C of the 
Contracts Database Original. Thus, there are no errors in the population until they are entered by 
an instructor.  

For example, assume an instructor planned to create created an error rate of 1.2% in the 
population with half the errors being incorrect approver and half being missing approval. First, 
the instructor created a copy of the Contracts Database Original. Next, the instructor selected 12 
random records and changed the Use column to “2”. Then the instructor selected an additional 12 
random records and set the Use column to “3”. 

Once the instructor made these changes to column B, the Contract Detail worksheet was 
hidden and password protected. (See Adding Password Protection below). When this is done, 
students will only see the Contract Look Up worksheet and will not know the actual content of 
the population. After the Contract Detail worksheet is hidden and protected, the case and Excel 
files can be distributed to students through the course’s learning management system. 

 
Adding Password Protection  

 
To hide and protect the Contract Detail worksheet containing the unique population: 
a. Hit “Alt” and “F11.” The “Project-VBA Project” dialog box will appear on the left 

side of the screen to allow the instructor to change the worksheet properties. Refer to 
Figure 4 in Appendix. If the dialog boxes do not appear they can be retrieved by 
selecting View -> Explorer Window or View -> Properties Window from the menu.  

b. Select “Sheet2” from the list of Microsoft Excel Objects. In the Properties window, 
change the “Visible” property to “2 – xlSheetVeryHidden” (refer to the bottom left 
corner of Figure 4 in Appendix). After you have completed this step, close the 
“Project-VBA Project” dialog box by selecting the “X” in the upper right corner of 
the sheet (not the program). The desktop view will only display one worksheet, 
Contract Look Up.  

c. Click Review-> Protect Workbook. A “Protect Structure” dialog box appears. Refer 
to Figure 5 in the Appendix. 
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Enter the password. Click OK. The system will ask you to confirm the password by 
presenting a “Confirm Password” dialog box. Reenter the password. Click OK. At this 
point, the only way to change the file and reveal the Contract Detail worksheet is to use 
the password. Use of a strong password is recommended. Remember to record the 
password in a secure location away from the original file.  
d. Save the Excel file. 
The author tested if students could access the hidden and protected worksheet by opening 
the Contracts Database Excel file in Google Sheets. The hidden worksheet was not 
revealed, reducing the possibility of students viewing the population under audit.  
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APPENDIX – Tables and Figures  

Table 1 

NtS’ Policy on Contract Approvals 

 

Initials of Approver Approval for Department Dollar Limit 

AJ A $6,500 

SP A $10,000 

MA B $6,500 

SK B $10,000 

LL C $6,500 

JJ C $10,000 

SJ D $6,500 

PW D $10,000 

WB A – D Over $10,000 

 

 

Figure 1 

The Contracts Ledger Table in ACL 
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Figure 2 

View of Contract Look Up Form in Contracts Database 

 

 
 
 

Figure 3 

Contract Detail Worksheet 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

  

The instructor makes changes 

only to the “Use” column. 
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Table 2 

Results for 25 Different Random Samples 

   Type of Error 

Number of 

Errors 

Frequency Projected 

Error Rate 

Incorrect 

Approver 

Missing 

Approver 

0 10 3.13% 0 0 

1 8 4.95% 3 5 

2 5 6.56% 5 5 

3 1 8.08% 1 2 

4 1 9.54% 4 0 

Total 25  13 12 

 

 

Figure 4 

The Project - VBA Project Dialog Box (for hiding worksheets) 
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Figure 5 

The Protect Structure Dialog Box (for Password Protection) 
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